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ANALYTICAL GRAPHICS, INC. (AGI) IS WILLING TO LICENSE
SATELLITE TOOL KIT (STK)® TO YOU ONLY UPON THE
CONDITION THAT YOU ACCEPT ALL OF THE TERMS IN THIS
LICENSING AGREEMENT.  BEFORE YOU OPEN THE
ACCOMPANYING SOFTWARE MEDIA, READ THE TERMS AND
CONDITIONS OF THIS LICENSE AGREEMENT CAREFULLY. BY
OPENING THE ACCOMPANYING SOFTWARE MEDIA, YOU ARE
CONSENTING TO BE BOUND BY AND ARE BECOMING A PARTY TO
THIS LICENSE AGREEMENT. IF YOU DO NOT AGREE WITH THE
TERMS AND CONDITIONS OF THIS AGREEMENT, AGI IS
UNWILLING TO LICENSE STK TO YOU, IN WHICH EVENT YOU
SHOULD RETURN THE UNOPENED SOFTWARE MEDIA AS WELL AS
THE DOCUMENTATION WITHIN THIRTY (30) DAYS OF PURCHASE
AND YOUR LICENSE PRICE WILL BE REFUNDED.

ANALYTICAL GRAPHICS, INC.

SOFTWARE LICENSE AGREEMENT

Analytical Graphics, Inc. (Analytical Graphics) provides the program
and manual (the "Software") and licenses its use to you.  You assume
responsibility for the selection of the Software to achieve your
intended results, and for installation, use and results obtained from the
Software.

1. LICENSE

(1.1) You may: (a) use this Software only on one single computer at
any one time (a "computer" being hereby defined as one central
processing unit, a single display and associated peripheral equipment,
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all at one location); and (b) make one (1) copy of the Software in any
machine in any readable form for backup purposes in support of your
own use of the Software on a single computer.
(1.2) You must reproduce and include the copyright and other
proprietary notices of Analytical Graphics on any copy of all or any
portion of the Software, and all such copies shall be subject to all the
terms and conditions of the Agreement.

(1.3) YOU MAY NOT USE, COPY, MODIFY OR TRANSFER
THE SOFTWARE OR ANY COPY, MODIFICATION OR
MERGED PORTION THEREOF, IN WHOLE OR IN PART,
EXCEPT AS EXPRESSLY PROVIDED IN THE AGREEMENT.

2. LIMITATION AND WARRANTIES

(2.1) THE SOFTWARE IS PROVIDED "AS IS" WITHOUT WARRANTY
OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING BUT
NOT LIMITED TO THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR
PURPOSE.  YOU ASSUME THE ENTIRE RISK AS TO THE QUALITY
AND PERFORMANCE OF THE SOFTWARE.  SHOULD THE
SOFTWARE PROVE DEFECTIVE, YOUR ENTIRE AND EXCLUSIVE
REMEDY SHALL BE GOVERNED BY PARAGRAPH 3 HEREOF.

(2.2) SOME STATES DO NOT ALLOW THE EXCLUSION OF
IMPLIED WARRANTIES, SO THE ABOVE EXCLUSION MAY NOT
APPLY TO YOU.  THIS WARRANTY GIVES YOU SPECIFIC LEGAL
RIGHTS AND YOU MAY ALSO HAVE OTHER RIGHTS WHICH
VARY FROM STATE TO STATE.

(2.3) Analytical Graphics does not warrant that the functions contained in
the Software will be uninterrupted or error free.  You are advised to test the
Software thoroughly before relying on it.
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3. LIMITATION OF REMEDIES

(3.1) IN NO EVENT WILL ANALYTICAL GRAPHICS OR ITS
SUPPLIERS, DISTRIBUTORS, OR DEALERS BE LIABLE TO YOU
FOR ANY DIRECT OR OTHER DAMAGES, INCLUDING ANY
LOST PROFITS, LOST SAVINGS OR OTHER INCIDENTAL,
SPECIAL OR CONSEQUENTIAL DAMAGES ARISING OUT OF
THE USE OR INABILITY TO USE THE SOFTWARE EVEN IF
ANALYTICAL GRAPHICS OR ANY AUTHORIZED ANALYTICAL
GRAPHICS DEALER HAD BEEN ADVISED OF THE POSSIBILITY
OF SUCH DAMAGES, NOR SHALL ANALYTICAL GRAPHICS BE
LIABLE FOR ANY CLAIM BY ANY OTHER PARTY.

(3.2) SOME STATES DO NOT ALLOW THE LIMITATION OR
EXCLUSION OF LIABILITY FOR INCIDENTAL OR
CONSEQUENTIAL DAMAGES SO THE ABOVE LIMITATION OR
EXCLUSION MAY NOT APPLY TO YOU.

4. TERMINATION

The license granted under this agreement is effective until terminated.  You
may terminate this license at any time by destroying all copies of the software
in your possession, and providing written notice of such termination and
destruction to Analytical Graphics.  The license granted under this
Agreement will terminate if you violate any of the terms and conditions of
the Agreement.  You agree upon such termination to promptly destroy all
copies of the Software in your possession and to certify in writing to
Analytical Graphics that such action has been taken.
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5. LAW TO GOVERN

This Agreement shall be governed by the laws of the Commonwealth of
Pennsylvania.

6. NO TRANSFER

None of your rights, duties or obligations under this Agreement may be sold,
sublicensed, assigned, rented, leased, loaned or otherwise transferred without
the prior written consent of Analytical Graphics, and any attempt to so sell,
sublicense, assign, rent, lease, loan or transfer without Analytical Graphics'
prior written consent is void.

7. YOU ACKNOWLEDGE THAT:

(a) YOU HAVE READ THIS ENTIRE AGREEMENT AND AGREE TO
BE BOUND BY ITS TERMS AND CONDITIONS;

(b) THIS AGREEMENT IS THE COMPLETE AND EXCLUSIVE
STATEMENT OF THE UNDERSTANDING AND CONTRACT
BETWEEN US AND SUPERSEDES ANY AND ALL PRIOR ORAL OR
WRITTEN COMMUNICATIONS RELATING TO THE SUBJECT
MATTER HEREOF; AND

(c) THIS AGREEMENT MAY NOT BE MODIFIED, AMENDED OR
IN ANY WAY ALTERED EXCEPT BY A WRITTEN AGREEMENT
SIGNED BY BOTH YOU AND ANALYTICAL GRAPHICS.
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8. NOTICES

Any notices regarding this agreement shall be sent to:

Analytical Graphics, Inc.
660 American Avenue, Suite 200
King of Prussia, PA 19406

9. ACCEPTANCE

By opening the accompanying software media, you agree to all of the terms
of this license Agreement.  If you do not agree to these license terms and
conditions, return the software within thirty (30) days of purchase for a
refund of the purchase price.

10. FREE WIDGET FOUNDATION WIDGET SET COPYRIGHT BY:

Copyright 1995 BertBos

Permission to use, copy, modify, distribute, and sell this software and its
documentation for any purpose is hereby granted without fee, provided that
the above copyright notice appears in all copies and that both that copyright
notice and this permission notice appear in supporting documentation, and
that the name of the author not be used in advertising or publicity pertaining
to distribution of the software without specific, written prior permission.
The author makes no representations about the suitability of this software
for any purpose.  It is provided "as is" without express or implied warranty.

The author disclaims all warranties with regard to this software, including all
implied warranties of merchantability and fitness, in no event shall the author
be liable for any special, indirect or consequential damages or any damages
whatsoever resulting from loss or use, data or profits, whether in an action of
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contract, negligence or other tortious action, arising out of or in connection
with the use or performance of this software.

11. XPM COPYRIGHT BY:

Copyright 1989-95 GROUPE BULL

Permission is hereby granted, free of charge, to any person obtaining a copy
of this software and associated documentation files (the "Software"), to deal
in the Software without restriction, including without limitation the rights to
use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies of
the Software, and to permit persons to whom the Software is furnished to do
so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in all
copies or substantial portions of the Software.

The Software is provided "as is," without warranty of any kind, express or
implied, including but not limited to the warranties of merchantability,
fitness for a particular purpose and noninfringement.  In no event shall
Groupe Bull be liable for any claim, damages, or other liability, whether in an
action of contract, tort or otherwise, arising from, out of or in connection
with the software or the use or other dealings in the software.

Except as contained in this notice, the name of Groupe Bull shall not be used
in advertising or otherwise to promote the sale, use or other dealings in this
Software without prior written authorization from Groupe Bull.

Agreed to this                                  day of                                                      19                  

By:                                                                                                                                          

Title:                                                                                                                                       
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 1

STK TUTORIAL

About this Tutorial

The SSTTK K TTuuttoorriiaall provides exercises that will assist you in developing a solid
understanding of the basic functions in STK as well as a brief introduction to
some of STK’s more advanced features and functions. For those who are
entirely new to aerospace analysis and/or STK, these first few pages provide a
general overview of both.

Satellite Tool Kit (STK)® is an aerospace analysis software package with
highly sophisticated capabilities. While you may be familiar with some of its
capabilities, you may be unaware of other interesting, time-saving features. If
your initial use of STK requires only simple modeling, you’ll find STK to be a
straightforward tool for accomplishing your work. As your needs become
more refined, you can learn to use STK’s more sophisticated resources to
assist with your most complex, demanding aerospace analysis tasks.
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This introduction presents a high-level, “big picture” of STK. It is intended
to help you develop a context in which to place the fine details of STK as you
begin to work with the program. Use the scenarios shipped with STK and the
tutorial that follows this introduction to become familiar with the basic
structure of STK as well as its functions and features.

This tutorial assumes that you’re familiar with the operating platform and are
used to maneuvering and mousing techniques.

Chapter Contents

About this Tutorial ...........................................................................................1

Chapter Contents............................................................................................2

STK Tutorial — Levels of Expertise....................................................................2

Conventions Used in This Manual...................................................................4

STK Professional Features ................................................................................5

Advanced Analysis .....................................................................................6

High Precision Orbit Propagator (HPOP) ...................................................8

Long-term Orbit Predictor (LOP) ................................................................9
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High Resolution Maps..............................................................................11

STK Tutorial — Levels of Expertise

This tutorial is intended to guide you through creating, using, and
manipulating a sampling of the many analysis tasks that can be performed
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with STK. The tutorial’s step-by-step approach shows you how to perform
tasks that may be part of your typical workday. Both new and experienced
STK users will benefit by working through this tutorial section by section.
The intermediate tasks in Section 2 depend upon a foundation of
components, data, and analysis performed in Section 1. Following is a
summary of each tutorial section, including goals and estimated completion
times.

Chapter 2:  Introductory Skills

The goal of Chapter 2 is to familiarize new STK users with the
components that comprise the Satellite Tool Kit. You’ll become
familiar with STK terminology and a number of standard STK
capabilities such as creating facilities, satellites and other vehicles,
sensors, and other objects that can be contained in a scenario. In
addition you’ll learn to set the display of graphis in the Map window
and animate the scenario over time.

◊ Task - To build a scenario from scratch.

◊ Estimated completion time - 1 hour

Chapters 3 & 4:  Intermediate Skills

The goal of Chapters 3 and 4 is to expand your skills so that you can
analyze satellite systems. You’ll generate orbits, review pass and
ephemeris data,  and calculate accesses and AER data. In addition,
you’ll learn to display sensor swaths, animate scenarios, change map
projections, generate reports and graphs for analysis purposes, and
print maps.

◊ Task - To propagate and analyze vehicle orbits.

◊ Estimated completion time - 1 hour



STK Tutorial

1-4 Satellite Tool Kit®  Tutorial

Chapter 5:  Advanced Skills

The goal of Chapter 5 is to learn to constrain objects, including
sensors, and to calculate accesses with constraints of varying degrees of
complexity. You’ll also learn to set lighting conditions, work with
sensor swaths, generate a Walker constellation and customize report
formats.

◊ Task - To define and display constraints, lighting
conditions and sensor swaths.

◊ Estimated completion time - 30 minutes

Conventions Used in This Manual

Certain typographic and formatting conventions have been followed in this
user’s manual to help you quickly and visually understand various kinds of
information:

♦ Keyboard keys are displayed as graphical representations of the keys. For
instance, 5 represents the Enter  key on a conventional keyboard.

♦ User commands that must be typed are shown in a typewriter font. For
example, # tar xvf /dev/rst0   is one of the commands used when
installing the STK product.

♦ Mouse conventions, such as click, double click and drag, are used often in
this manual. Click means to press and release a mouse button. Double
click means to press and release a mouse button twice in rapid succession.
Click and drag means to press and hold a mouse button while moving the
mouse, then release the button once you stop moving to define an area on
the screen. Unless otherwise noted, use the left mouse button to perform
actions.
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♦ Window/screen buttons are displayed in a sans serif font or a picture of
the button is displayed. For instance, the manual may refer to the OK
button or just display the button as .

♦ Window titles are displayed in a bold italic sans serif font, while tabs within
a window are displayed in bold sans serif and fields in plain sans serif. For
example, the Map Background tab of the Graphic Properties  window
contains the Background Image File field.

♦ Notes to the reader are located in a shadowed box. Information contained
in these notes is important and should be taken into consideration. Notes
are identified by the heading 1RWH and a  icon in the outside margin.

♦ Hints to the reader are located in a shadowed box. Hints may contain
shortcuts or helpful information to make your work easier. They are
identified by the heading +LQW and a  icon in the outside margin.

♦ Warnings to the reader are located in a shadowed box. Warnings contain
important information for the user that may cause problems if not
followed. They are identified by the heading :DUQLQJ and a  icon in
the outside margin.

STK Professional Features

Some of the features and functions described in this manual are available only
with the STK PRO software suite or with individual add-on modules that
address your requirements.  Because these functions are embedded in the
STK application, they are presented in this manual. However, they can be

identified by the STK logo ( ) in the outside margin. The modules
available as part of the PRO suite or as individual add-on modules are:



STK Tutorial

1-6 Satellite Tool Kit®  Tutorial

Advanced Analysis

The Advanced Analysis module (AAM) provides a package of advanced
features and tools that dramatically extend the capability of STK. This
module is designed to meet the requirements of satellite systems engineers
performing a wide variety of specialized analysis tasks. Specifically, these
features offer advanced functionality in five areas: attitude simulation and
targeting, sensor definition and constraints, astrodynamics, data
visualization, and data management.

Attitude Simulation & Targeting

Attitude simulation and targeting features allow users to define a vehicle’s
attitude by: (1) using one of fifteen pre-defined pointing profiles, (2)
numerically integrating the torques operating on the vehicle’s physical mass
matrix, or (3) defining its orientation relative to a specified target. This
attitude data is typically used with sensor information to resolve complex
geometries when computing ground site visibility and link accesses.

Sensor Definition and Constraints

Sensor definition features allow characterization of alternative sensor types
and parameters. This includes targeting gimbaled sensors, customization of
non-conical sensor patterns, and characterization of specific parameters for
optical sensors. Sensor constraint features support a diverse and sophisticated
set of parameters characterizing sensor access limitations.

PRO/
Advanced
Analysis
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Astrodynamics

Astrodynamics features enable use of specialized alternative orbit element
sets and coordinate systems each offering unique analysis advantages.

Data Visualization

Data visualization features exploit the special advantages of eight alternative
map projections for visualization of ground based information. Additionally,
area targets are provided as STK objects and visualization of vehicle and
sensor swaths is supported.

Data Management

Data management features include three data input/output (I/O)
convenience functions. Custom reports allow users to specify precisely those
output parameters important to their analyses. This allows more concise
reports containing only the data of interest. Batch processing options allow
users to predefine a series of mission scenarios exercising the important
parameter space for a given problem. These are then automatically processed
sequentially in the background storing the results in data files for later
evaluation. Lastly, databases of facilities, cities, and stars are provided.
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High Precision Orbit Propagator
(HPOP)

A state-of-the-art orbit generator that can generate orbits for a wide variety
of Earth satellites. It can handle circular, elliptical, parabolic and hyperbolic
orbits at distances ranging from the surface of the Earth to the orbit of the
Moon and beyond.

The HPOP includes modern, high-fidelity models for all of the major
perturbations affecting an Earth satellite:

♦ Joint Gravity Model (JGM) 2, an advanced 70x70 spherical harmonic
expansion offering the highest accuracy currently available in an
unclassified Earth potential model.

♦ Lunar/solar point-mass gravitational effects, using the U.S. Naval
Observatory Compressed Ephemeris to predict the positions of the Sun
and Moon. This ephemeris is accurate to within 0.03 arc second.

♦ Atmospheric drag, using the Harris Priester atmosphere model, modified
to take into account the diurnal bulge and the variation in the Sun’s
extreme ultraviolet flux, to compute the atmosphere density. The drag
model assumes single-collision specular reflection, which is appropriate for
most satellites. Departures from this can be modeled by changing the area-
to-mass ratio of the satellite.

♦ Solar radiation pressure, which assumes that the satellite is either a mirror
sphere or a black body. Solar radiation pressure is the same for mirror
spheres and black bodies with the same cross-sectional area, so that users
need not specify the characteristics of the satellite.

The HPOP also takes into account all of the major predictable motions of
the Earth that affect the apparent position of the satellite:

♦ Precession of the equinoxes

♦ Nutation

PRO/PRO/
HPOPHPOP
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♦ Diurnal rotation

♦ Barycentric displacement

In addition, the HPOP accounts for the differences among the three primary
astronomical time systems:

♦ Universal Time Coordinated (UTC), also known as Greenwich Mean
Time (GMT)

♦ International Atomic Time (TAI)

♦ Terrestrial Dynamic Time (TDT), formerly known as Ephemeris Time
(ET)

All input and output are expressed in terms of UTC; TAI and TDT are used
internally to achieve increased accuracy.

For ultra-high-precision, the HPOP uses the Runge-Kutta-Fehlberg method
of order 7-8 to integrate the equations of motion.

Long-term Orbit Predictor (LOP)

The Long-term Orbit Predictor module (LOP) allows accurate prediction of
a satellite’s orbit over many months or years. This is often used for long
duration mission design, fuel budget definition, and end-of-life studies. For
performance reasons, it is impractical to compute the long-term variation in a
satellite’s orbit using high accuracy, small time step, propagators that
compute a satellite’s position as it moves through its orbit. LOP exploits a
“variation of parameters” approach which integrates analytically derived
equations of motion computing the average effects of perturbations over an
orbit. This approach allows large multi-orbit time steps and typically
improves computational speed by several hundred times while still offering
high fidelity computation of orbit parameters.

PRO/PRO/
LOPLOP
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User inputs include an initial orbit and satellite mass, area, and drag
coefficient. The program implements the 1976 standard atmosphere to
compute the drag effects. Additionally, LOP considers the effects of the
Earth’s oblateness (through J21), the resonant effects of tesseral harmonics,
solar and lunar gravity, and solar radiation pressure when computing the
orbital perturbations. The module is based on algorithms provided by
NASA’s Jet Propulsion Laboratory.

Lifetime

Lifetime estimates the amount of time a low Earth orbiting satellite can be
expected to remain in orbit before the drag of the atmosphere causes reentry.
While the computational algorithms are similar to those implemented in the
Long-term Orbit Predictor, there are some important differences. First, a
much more accurate atmospheric model is implemented to compute the drag
effects. The gravitational model for the Earth, however, is significantly
simplified since the inclusion of the higher order terms doesn’t impact orbit
decay estimates. This allows significant performance advantages and provides
a quicker turn around for the analyst.

User inputs include an initial orbit and satellite mass, area, and drag
coefficient. The program implements the Jacchia 1971 atmospheric model to
compute the drag effects. Additionally, Lifetime considers the effects of the
Earth’s oblateness (through J5), solar and lunar gravity, and solar radiation
pressure when computing the orbital perturbations. The module is based on
algorithms developed at NASA’s Langley Research Center.

PRO/PRO/
LifetimeLifetime
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Terrain

The Terrain module provides precise three-dimensional (3-D) terrain
elevation data for the entire globe. When used with  STK, Terrain exploits
sophisticated multi-dimensional interpolation algorithms to provide accurate
360° azimuth/elevation masks for satellite access calculations from any point
on the Earth’s surface. These algorithms also provide altitude information for
user defined facilities and ground based targets. For users of the VO module,
Terrain allows a vivid 3-D visual depiction of the Earth’s true surface relief
and its effect on satellite accesses.

The data has a resolution of less than 30 arc-seconds or approximately 1
kilometer at the Earth’s surface. In its compressed format, the complete data
set requires over 400 MB of storage. However, the data can be read directly
from the CD-ROM without loading it onto your hard disk. This data was
originally compiled by the U. S. Geologic Survey from a variety of sources
around the world. It has been processed and formatted for optimal
performance with STK.

High Resolution Maps

This module contains comprehensive, very-high-resolution mapping data for
the entire globe. The data includes coastlines, rivers, lakes and political
boundaries at approximately 1 arc second or 30 meter resolution. This is ideal
for visualizing ground tracks and coverage areas over small geographic
regions. Special data access algorithms have been incorporated to support
rapid visualization of localized map data. The data was extracted from the
1995 CIA RWDB2 database and requires almost 200 MB of storage. It is
formatted for optimal performance with STK.

PRO/PRO/
TerrainTerrain

PRO/PRO/
Hi-ResHi-Res
MapsMaps



STK Tutorial

1-12 Satellite Tool Kit®  Tutorial

 127(6�



Satellite Tool Kit® Tutorial 2-1

2
INTRODUCTORY

SKILLS

Goal for this Section

New users who complete this section will acquire the skills necessary to
create and manipulate Satellite Tool Kit (STK) objects (e.g., scenarios,
targets, vehicles and sensors). You’ll become familiar with the structure of
static and dynamic elements of the STK database and learn how to save
objects to and retrieve objects from the database. After creating various STK
objects, you’ll learn how to animate the scenario to display time-dependent
information in the Map window. For previous STK users, this section serves
as a refresher for basic STK operations and also highlights a number of new
features to help you use STK more effectively.
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Getting Started

The directory in which STK is installed contains a subdirectory called tutorial
that you’ll being using to store the data generated during this tutorial.
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With your STK software, you received an stkDemo scenario and associated
data files. By default, these files were loaded in <Install
Dir >/STKv3/Data . The files are currently located in the master STK
directory, which is globally shared by all STK users on your system.

If STK is installed on a UNIX platform and you haven’t yet run STK, you
must first identify the directory in which STK is located.

If you haven’t yet run STK and <Install Dir>/STKv3/bin  is not in your
current path, you must type the fully qualified path: <Install Dir>/

STKv3/bin/stk .

Starting STK

Start STK by typing stk  and pressing 6 at the user prompt.

Creating the Tutorial40 Scenario

The scenario is the highest level object in STK; it includes a map and contains
all other STK objects (e.g., satellites, facilities, etc.). This section of the
tutorial guides you through the process of creating and populating a scenario.

This exercise assumes that you are just opening STK.

When you first start STK, a Startup Wizard appears along with the STK
Browser window.
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To create a new scenario, click the  (Scenario icon) to the left of the Create
a New Scenario field in the Startup Wizard.

A Map window appears.

To name the new scenario, double click on the name Scenario# in the
Browser window, type the word Tutorial40 in the highlighted text and press
5.
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The Browser window is updated to reflect the new name.

For publication purposes, map colors have been reversed. In most instances, the Map
window is a color-on-black display.

To change the size of the Map window, click and hold the mouse button on any of the
corners and drag the window border. When you release the mouse button, the window

re-sizes. Click the   button on the Map window tool bar to ensure that the correct 2:1
aspect ratio is preserved.

We are now ready to start building a scenario.

Setting the Tutorial40 Environment

Before performing any tasks in STK, we need to set parameters that will
affect all aspects of your scenario as it is built. To perform the tasks set out in
this tutorial, please use the settings in the subsections following.

1RWH
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Setting Application Properties

You can alter parameters at any time during your session.

First, we need to set parameters for the STK application. These higher-level
parameters affect every object within the application, regardless of the
scenario currently open. To set parameters for the STK application, first
ensure that the STK application (indicated by the  icon) is highlighted in
the Browser window. Click the Properties menu and highlight Basic in the
pull-down menu.

A Basic Properties window appears.

Setting Save Preferences

It’s important to save your work frequently to prevent loss of data. You can
use the Auto Save feature in STK to save your work for you.

It is a good idea to set Auto Save for your normal STK sessions as well as for this tutorial.

Save Prefs aren’t saved when you exit STK; you must reset these options each time you run
STK or use the Set as Default option for the scenario level.

1RWH
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For the purposes of this tutorial, make sure the Save Period is set to 5
minutes, the Auto Save and Save Vehicle Ephemeris features are ON, and the
Binary Format and Save Accesses options are OFF. Click OK to apply the
changes and dismiss the Basic Properties window.

Setting Scenario & Map Properties

It is important to set parameters at the scenario level as well as the
application level. We’re going to set units of measure to be used throughout
the scenario and also set map graphics so that the display of objects in the
Map window are easily visible.

Setting Units

Set the units of measure to be used throughout the scenario by
highlighting the Tutorial40 scenario in the Browser window and
selecting Basic in the Properties pull-down menu.
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First, change the scenario’s Start Time and Epoch to 1 Nov 1997 00:00:00.00
and its Stop Time to 1 Nov 1997 04:00:00.00. Click the Animation tab.

To ensure that the Map window is set to the correct time period, make sure
the  Start Time of the Animation to 1 Nov 1997 00:00:00.00.  Now
click the Units tab.
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For the purpose of this tutorial, set Units fields as shown in the table
following. To change the default settings, highlight the unit of interest in the
Units list then select the correct unit in the Change Unit Value list.

To select an item from a list, click the item so that it is highlighted. To deselect it, click the
item again until it is no longer highlighted.

Table  2-1.  Tutorial40 unit settings

Field Setting

Distance Unit 1DXWLFDO 0LOHV �QP�

Time Unit +RXUV

Date Format *UHJRULDQ 87&

Angle Unit 'HJUHHV �GHJ�

Mass Unit .LORJUDPV �NJ�

Power Unit G%:

Frequency Unit *+HUW] �*+]�

SmallDistanceUnit 0HWHUV �P�

LatitudeUnit 'HJUHHV �GHJ�
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Field Setting

LongitudeUnit 'HJUHHV �GHJ�

When you finish, click OK.

Setting Graphics Properties

Parameters for map graphics control the display of data and the functions
available in the Map window. To set the graphics properties for the scenario,
click the  button on the Map window tool bar to open the Map Properties
window for the Map.

Setting Map Attributes

Map attributes control the display of data such as orbit paths, object names,
ground tracks and other satellite data. You can also control the display of the
tool bar at the top of the Map window and other selections through this
window.
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In the tab shown here, the Show Tool Bar option is ON and the Show Elevation Regions
option is OFF.

For the purposes of this tutorial, make sure the Show Tool Bar, Show Status
Bar and Show Scroll Bars options are ON and the Show Elevation Regions
option is OFF.

When you finish, click the Details tab.

Setting Map Details

Now let’s set map details. The options in the Details tab control the display
of land mass and other map features such as the display of latitude and
longitude lines in the background and the image resolution of details in the
Map window.

For the purposes of this exercise, set the options in the Details tab as follows:
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Table  2-2.  Map Details options

Field Setting

Items Highlight RWDB2Coastlines and RWDB2Lakes. Make sure
that no other option is highlighted in the Items list.

Lat/Lon Lines Turn Latitude and Longitude Lines OFF.

Background Image Make sure the Background Image field is set to None and the
Color is set to Black.

When you finish, click the Projection tab.

Setting Map Projection

Now let’s set parameters for map projection. Map projection controls the
way in which the three-dimensional (3-D) globe is presented in the Map
window.

For the purposes of this tutorial, select the Equidistant Cylindrical Projection
Type. When you finish, click the Text Annotation tab.
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Annotating Text

You can also annotate the Map display in the Map window at a specified
latitude and longitude and/or at a specific X,Y coordinate.

To move from field to field, press 7�

To overwrite a displayed value, double click in the field you wish to modify.

Let’s add new text to the Map window. In the Text box, type “My
Tutorial.”  Now select the X,Y Position option, click in the first text box to
the right of the Position field and enter -160.0  as the X coordinate. In the
second text box, enter -60.0 as the Y coordinate. Change the display color
to Royal Blue. When everything is set, click the Insert Item button.

When you finish, click OK.

A Map window similar to the one shown here appears. The map
is updated to reflect the changes you made to the application and
scenario parameters as well as the display of map graphics.
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Creating Facilities

Now we’re going to populate the scenario with various objects. Let’s start
with facilities such as ground stations, launch sites and tracking stations.

As the cursor moves over an icon in the Object Menu, the icon’s purpose is annotated at
the bottom of the Browser window.

Click the  (Facility icon) in the lower portion of the Browser window.
Change the facility’s name to Baikonur by double-clicking on the default
name and typing the new name in the highlighted text. Press 5 WR apply
the new name.

The Browser window is updated to include the new facility and
the Map window displays the facility at the default 0° latitude, 0°
longitude position.

Now select Basic from the Properties menu.
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You can also use the right mouse button to display menu that includes Properties and
Tools for any object.

Setting the Facility’s Position

The first tab in the Basic Properties window is the Position tab. Position
controls the placement of the facility on the map.

For the purposes of this tutorial, set the options in the Position tab as
follows. Make sure the Local Time Offset from GMT and Use Terrain Information
options are OFF.

Table  2-3.  Baikonur position settings

Field Setting

Position Type Geodetic

Latitude 48.0

Longitude 55.0

Altitude 0.0

+LQW
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You can also position a facility by opening the facility’s Basic Properties, moving the cursor
in the Map window to the desired location (observing the cursor position values displayed
in the lower left-hand corner of the Map window), then clicking the left mouse button
when the correct position is achieved. If you’re using the cursor to set the position, you
may want to Zoom In on a specific area to improve your placement accuracy.

Now click the Description tab.

Identifying the Facility for Future
Reference

Use the Description tab to provide a brief and/or detailed description of the
facility for future reference.

If you have a Comm license, the facility's Basic Properties window also contains an
Atmosphere tab. To learn more about the Comm module, please consult the Comm User’s
Manual.

+LQW
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For the purposes of this tutorial, enter the following text in the
Description tab:

Table  2-4.  Descriptions

Field Setting

Short Description Launch Site

Long Description Russian launch site located in Siberia

Click OK.

Adding More Facilities

Now that we’ve added one facility to the scenario, it will be an easy task to
add four more new facilities to the Tutorial40 scenario. Use the procedures
described above to add the facilities listed in Table 2-5 There is no need to
provide a Long Description for any of the facilities.

Table  2-5.  Settings for Perth and Wallops facilities

Name Latitude Longitude Altitude Short

Perth -31.0 116.0 0.0 Australian Tracking
Station

Wallops 37.8602 -75.5095 -0.0127878 NASA Launch
Site/Tracking Station

When you finish defining each facility, click OK.

We still need to add two more facilities to the scenario. This time, we’ll use
the Facility Database tool to easily add the facilities.
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Adding Facilities Using the Facility
Database

In the Browser, highlight the Tutorial40 scenario and select Facility Database
from the Tools menu.

Turn the Network option ON and select NASA DSN as the Network.  Now
click Perform Search….

PRO/
Advanced
Analysis
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When the Facility Database Search Results window appears, scroll to the bottom of
the list, then highlight Santiago and WhiteSands in the list and click OK. In the
Facility Database window, click Cancel.

In the Browser window, highlight Baikonur, press and hold the 6 key and
highlight each of the other facilities (all five facilities should now be highlighted), then
right mouse click and select Graphics from the menu that appears.
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In the Attributes tab, change the Marker Style so that it displays the facility
icon. Click OK.

The Browser and Map windows are updated.

 

When objects are inserted using any of the databases shipped with STK,
descriptions are automatically generated for the objects.  Let’s look at the
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description generated for the Santiago facility. Open the Basic Properties
window for the Santiago facility and select Description.

Notice that the Long Description field includes position and other data
associated with the facility. Click OK.

Creating Targets

The target for this exercise is a glacier field over North America. Click the
 (Target icon) in the lower portion of the Browser window, then click in

the new target’s name, change it to Iceberg  and press 5.

The Browser window is updated to include the new target.

Select Basic from the Properties menu.
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Setting the Target’s Position &
Description

The first tab in the Basic Properties window is the Position tab.

We need to set latitude, longitude and altitude values for the newly created
target. In the Description tab, we’ll enter a short description.

For the purposes of this tutorial, set Position and Description fields according
to Table 2-6 below; set the Position Type to Geodetic.

Table 2-6.  Settings for the Iceberg target

Name Latitude Longitude Altitude Short

Iceberg 74.91 -74.50 0.0 Only the Tip

When you finish, click OK. To better see the target in the Map window, open
its Graphics Properties window and change the Marker Style to the target icon.
Click OK.
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The Map window is updated to include the new target.

Creating Ships & Satellites

Next, we’ll create and define a ship and a number of satellites.

Creating a Ship

Let’s begin by adding a ship to the Tutorial40 scenario. Click the  (Ship
icon) and change the new object’s name to Cruise . Press 5 to apply
the new  name.

The Browser window is updated to include the new ship.

Open the Basic Properties window for the ship (Properties menu/Basic).
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In the Route tab, make sure the Start Time is set to 1 Nov 1997 00:00:00
and the Propagator is set to Great Arc.

Once you enter a Rate and Start Time for a great arc vehicle (ship, aircraft or ground
vehicle), STK calculates the Stop Time, which can’t be changed by the user.

Begin entering the waypoint values, shown in Table 2-7, for the Cruise
ship in the text boxes just below the Waypoints Table. When you finish a
line of data, click the Insert Point button.

Table  2-7. Cruise ship waypoints

Latitude Longitude Altitude Rate Turn Radius

44.1 -8.5 0.0 4.9 0.0

51.0 -26.6 0.0 4.9 0.0

52.1 -40.1 0.0 4.9 0.0

60.2 -55.0 0.0 4.9 0.0

68.2 -65.0 0.0 4.9 0.0

72.5 -70.1 0.0 4.9 0.0

74.9 -74.5 0.0 4.9 0.0

Setting the Attitude for a Ship

Now we need to set the attitude of the Cruise. Click the Attitude tab in the
Basic Properties window, and make sure that ECI velocity alignment with nadir
constraint is showing in the Attitude Type field.

1RWH
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When you finish, click OK.  In the Map window, click the  Reset button.

The Map window is updated to reflect the changes made.
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Creating Satellites

Now let’s add a few satellites: ERS1, Shuttle, TDRS_East and TDRS_West.

During the remainder of this exercise, we want the Time Units for the scenario
displayed in seconds. Open the scenario’s Basic Properties window and select
the Units tab. Change the Time Unit to Seconds, then click OK.

STK recalculates all time-related entries to coincide with the new Time Unit set.

Now we can begin adding the satellites. First we’re going to add two
Tracking & Data Relay (TDRS) satellites.  In the Browser window, click the

 (Satellite icon).

An Orbit Wizard appears.

Click Next. Now select Geostationary and click Next.
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In the Geostationary Orbit Wizard window, make sure the Subsatellite
Longitude is set to -100.0, then click Next. Finally, change the Start and Stop
Times to 1 Nov 1997 00:00:00.00 and 2 Nov 1997 00:00:00.00 and click Finish.
Now change the satellite’s name to TDRS.

We’re just going to insert the next TDRS satellite.  Highlight the Tutorial40
scenario in the Browser, then select Insert… from the Files menu. When the
Insert window appears, make sure you’re in the tutorial subdirectory, then set
the File Type to satellites and select TDRS_4.sa in the list of available files.

To resize the Browser window (or any other window in STK) so that data and graphics
appear in their entirety, click and hold a corner of the window and drag it to the size you
wish.

Propagating TDRS Orbits

Now we’re going to propagate the orbit of the second TDRS satellite. Open
the Basic Properties window for the TDRS_4 satellite. In the Orbit tab, make
sure the Start Time is set to 1 Nov 1997 00:00:00.00  and the Stop Time
to 2 Nov 1997 00:00:00.00.  Make sure that the Step Size is set to 60
seconds, then click OK.

+LQW
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The ground tracks for both satellites display in the Map window as specks
since they are in geostationary orbit. To better see both satellites in the Map
window, make sure both satellites are highlighted, click the right mouse
button and select Graphics from the menu that appears. In the Graphics
Properties window, select the satellite icon as the Marker Style. Click OK.

Adding more satellites

In the Browser window, click the  (Satellite icon). When the Orbit Wizard
appears, click Cancel. Change the new satellite’s name to ERS1.

The orbital element sets for these satellites are fictitious, and do not represent the true
orbital parameters. These orbital parameters are used for training purposes only and
should not be used to launch actual satellites.

Now we need to set the parameters for our new satellite. Open the Basic
Properties window for the ERS1 satellite.

Any parameter with more than one option displays a down-pointing arrow.

:DUQLQJ
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Enter the orbital parameters for ERS1, found in Table 2-8. Use the right
mouse button and the down-pointing arrow  to change the default RAAN
(Right Ascension of the Ascending Node) option to Lon Ascn Node
(Longitude of Ascending Node) before entering the value listed in the table.

Table  2-8.  Orbital elements for ERS1

Orbital Element Setting

Propagator J4 Perturbation

Start Time 1 Nov 1997 00:00:00.00

Stop Time 1 Nov 1997 04:00:00.00

Step Size 60.00

Orbit Epoch 1 Nov 1997 00:00:00.00

Coordinate Type Classical

Coordinate System J2000

Semimajor Axis 3867.7846
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Orbital Element Setting

Eccentricity 0.0

Inclination 98.50

Argument of Perigee 0.0

Lon Ascn Node 99.38

True Anomaly 0.0

When you finish, click OK.

The Map window is updated to include the ground track for the
requested orbit.

You can change pass characteristics to see the effect on the graphics. For
instance, open the Graphics Properties window for ERS1 and select the Pass
tab.
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To display only the descending side of the orbit, change Visible Sides from
Both to Descending and click Apply.

When you finish, return the Visible Sides option to Both and click OK.
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Now let’s add another satellite. Click the  (Satellite icon). When the Orbit
Wizard appears, click Cancel. Change the new satellite’s name to Shuttle.
Open the Basic Properties window for the Shuttle and enter the parameters
using the procedures introduced for ERS1 and the specific settings provided
in Table 2-9.

STK automatically converts negative values into their positive counterparts.

Use the right mouse button and the down-pointing arrow  to change the
default RAAN option to Lon Ascn Node and to change Semimajor Axis to
Apogee Altitude before entering the value listed in the table.

Table  2-9.  Orbital elements for the Shuttle

Orbital Element Setting

Propagator J4 Perturbation

Start Time 1 Nov 1997 00:00:00.00
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Orbital Element Setting

Stop Time 1 Nov 1997 03:00:00.00

Step Size 60.0 sec

Orbit Epoch 1 Nov 1997 00:00:00.00

Coordinate Type Classical

Coordinate System J2000

Apogee Altitude 200.0 nm

Perigee Altitude 200.0 nm

Inclination 28.5

Argument of Perigee 0.0

Long of Ascending Node -151.0

True Anomaly 0.0

When you finish, click OK.

Changing Object Attributes

Once you add the Shuttle satellite parameters, you can change the line style
and/or color of the ground track to distinguish it from other vehicle (i.e.,
satellites, ships, aircraft, etc.) ground tracks. Highlight the Shuttle in the
Browser window, right mouse click and select Graphics from the pull-right
menu.



2-34 Satellite Tool Kit® Tutorial

In the Attributes tab, change the Line Style to Long Dash, the Marker Style to
Plus and click Apply.

The Map window is updated to display your changes.

Now select the Contours tab.
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We’re going to look at elevation angle contours for the Shuttle. In the
Contours tab, make sure the Add Method is set to Start, Stop, Step, then enter
0, 50 and 10 for the Start, Stop and Step values and click Add. Attributes for
each of the five levels you added can be set separately. In the Level list,
highlight the first level (0.00)and turn OFF the Label option. Now do the
same for the remaining levels. Turn the Show Elevation Angle Contours option
ON, then click OK.

To see the contour levels, click the  Reset button in the Map window.

This Map view is zoomed to provide a better view of the SearchArea area target.
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Sampling Map Projections

We can also see the orbits for the satellites in a 3-D perspective. In the
Browser window, highlight the Tutorial40 scenario and select New Map
Window from the Tools menu. When the second Map window appears, click
the  button in the tool bar to open its Graphics Properties window. Now
select the Projection tab.
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For the purposes of this tutorial, change the Projection Type to Perspective,
then enter -3.418

0
 as the Latitude,  54.99

0
 as the Longitude, and 20000

nm as the Altitude. Set the 3-D Orbit Display to ECI (Earth-Centered Inertial)
and click Apply to view the changes in the Map window. Click OK.

To display graphics in the Map window, it is sometimes necessary to use the  Reset
button.

PRO/
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Adding an Area Target

Now, we’re going to create an area target. Area targets are used to define
geographical points of interest on the ground. For the purposes of this
tutorial, we’re going to assume that the Cruise ship has run into the Iceberg.
We’ll create an area target that defines the search area for any survivors and
salvageable equipment. Click the  (Area Target icon) in the lower portion
of the Browser window, then name the new area target SearchArea.

Open the Graphics Properties window for SearchArea. In the Attributes tab,
change the Line Width to 3� select None as the Marker Type and turn OFF the
Inherit Settings and the Show Label options. Click OK.

Now, let’s define the target. Open the Basic Properties window for the area
target.

In the text boxes below the Points Table, enter the Latitude and Longitude
values found in Table 2-10. After you enter each latitude/longitude
pair, click the Insert Point button.

PRO/
Advanced
Analysis
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Table  2-10.  Area target boundary points

Latitude Longitude

78.4399 -77.6125

77.7879 -71.1578

74.5279 -69.0714

71.6591 -69.1316

70.0291 -70.8318

71.9851 -76.3086

Now click the Centroid tab.

Turn OFF the Auto Centroid Compute option. Now change the Position Type
to Spherical and enter 74.9533  as the Latitude, -74.5482  as the Longitude,
and 3433.1462149  as the Radius.

When you finish, click OK.

Now let’s make sure that the Map window display clearly shows the area
target. Open the Graphics Properties window for the Iceberg target, change
the Marker Style to X, then click OK.
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When the Inherit Settings and Show Label options are OFF, no marker or label appears in
the Map window for the area target. However, the perimeter of the area target is shown.

The center of the area target is very close to the Iceberg target
marker because the search pattern radiates outward from the area
of impact.

This Map view is zoomed to provide a better view of the SearchArea area target.

Let’s leave the search efforts for now and do some sensor exercises.

Adding Sensors

In the Tutorial40 scenario, two sensors must be attached to ERS1: a horizon
sensor and an ERS1 downlink antenna.

1RWH
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In the Browser window, highlight ERS1, click the  (Sensor icon) and name
the new sensor Horizon. The Browser window is updated to include the new
sensor as a subclass of the ERS1 satellite.

Now open the Basic Properties window for the Horizon sensor. We need to
define the sensor and its targeting properties.

In the Definition tab, make sure the Sensor Type is set to Conical. Leave the
default Half-angle and Clock Angle values and select the Pointing tab.

The Horizon sensor has been defined to give a full field of view for the satellite. This
represents everything on the Earth that can be seen from the position of the spacecraft.
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We want to point the sensor straight down relative to the ERS1 satellite. To
do this, verify that the Pointing Type is set to Fixed and Elevation is set to 90.0

0

.

When you finish, click OK.

The Map window doesn’t immediately display sensor graphics. You must animate the
scenario to see sensor data.

Animating the Scenario

First, let’s clean up Shuttle graphics so that the sensor can be easily seen in
the Map window.  Open the Graphics Properties for the Shuttle satellite and
select the Contours tab.  Now turn OFF the Show Elevation Angle Contours
options and click OK.

Animation is controlled from the tool bar in the Map window, shown below. Click
the Reset  button, then click Animate Forward  to begin the animation.
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You can see the Horizon sensor as the field of view for the ERS1
satellite.

Stop the animation by using Reset  or Pause .

Now add the Downlink sensor to the ERS1 satellite using the procedures
introduced above.

To set the properties for the Downlink sensor, open its Basic Properties
window.
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In the Definition tab, set the Sensor Type to Half-Power, the Freq to 0.85
GHz and the dish Diameter to 1.0  meter. When you finish, select the
3RLQWLQJ tab.
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We want this sensor to point at our ground stations. To do so, change the
Pointing Type to Targeted and the Boresight Type to Tracking. Now select the
Baikonur facility in the Available Targets list and use the  to copy it the
Assigned Targets list. Repeat this procedure until all of the facilities appear in
the Assigned Targets list. When you finish, click OK.

To remove an object that appears in the Assigned Targets list, use the  button.

To display the new data, we need to animate the scenario. Use the Animate

Forward  button to begin animation and let the animation run until the
ERS1 satellite moves over the Santiago facility.

You can see the Downlink sensor appear and disappear as
facilities come in and out of the field of view. The Map window
shows the Downlink sensor as it passes over the Santiago facility.

When you finish, click Reset  to stop the animation and reset it at the
animation start time.

PRO/
Advanced
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Adding Sensors to Targets and
Facilities

When specifying targets and facilities, you may want to limit access to a
particular target or facility by more than the horizon limit. To demonstrate
this type of sensor, create a sensor named FiveDegElev  and attach it to the
Wallops facility.

To set the properties for the new sensor, open its Basic Properties window.

In the Definition tab, select Conical and set the Inner Half-angle value to 0.0
0

and the Outer Half-angle value to 85.0 °. Leave the default values for the Clock
Angles. Now select the Pointing tab.

In the Pointing tab, make sure that the Pointing Type is set to Fixed and that
Elevation is set to 90.0 °. Click OK.

Next, open the sensor’s Graphics Properties window and select the
Projection tab. In the Projection tab, set the Maximum Altitude to 424.0  nm
and the Step Count to 1� then click OK.

Now the 5° elevation ring around Wallops is defined and
graphically displayed.

The Map window shown here is zoomed to more clearly display the FiveDegElev sensor
around Wallops.

PRO/
Advanced
Analysis
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Now we need to save this sensor so that we can also use it for the WhiteSands
facility. To do this, highlight the FiveDegElev sensor in the Browser window, then
select Save from the  Files menu.

Now let’s add that same sensor to the WhiteSands facility. In the Browser window,
highlight WhiteSands, then select Insert… from the Files menu. When the Insert
window appears, change the File Type to Sensor and select the FiveDegElev.sn.

The Map window is updated to display the new sensor around
WhiteSands.
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Cleaning Up

If you wish to save the Cruise ship  or the SearchArea, you must do so before you remove
them from the scenario. If you don’t save them, they won’t be available for other tasks.

It’s time to clean up the Tutorial40 scenario. Search efforts for the survivors
of the Cruise ship mishap were successful. All passengers and crew members
have been rescued and a majority of the equipment was salvaged. As a result,
we need to update the Tutorial40 scenario to reflect the changing
circumstances. In the Browser window, highlight the Cruise ship and select
Remove from the Files menu.

The ship has been removed from the scenario.

Use these same directions to remove the SearchArea area target from the
scenario.

Saving the Scenario

Before proceeding to Chapter 3, Intermediate Skills, or if you wish to stop
here, you should save your new scenario. Highlight the Tutorial40 scenario
in the Browser window, and select Save from the Files menu.

The system saves the scenario and all objects created for and
inserted into the scenario.

To exit STK, select Exit from the Files menu.

:DUQLQJ
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At the Confirm window, click OK or Cancel to return to the current STK
session.
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3
INTERMEDIATE

SKILLS

Goal for this Section

The objective of this section is to learn how to propagate and analyze satellite
orbits, to manipulate the components of a scenario to acquire specific
information, and to graphically represent the results of the manipulations.
You’ll generate orbits, review pass and ephemeris data, and calculate accesses
and AER data. You’ll also learn to display satellite swaths, animate scenarios,
change map projections and print maps.

Chapter Contents

Getting Started.............................................................................................3-2

Defining a Satellite Orbit...............................................................................3-3

Changing Orbital Parameters .................................................................3-4

Display Times for Satellites ............................................................................3-7
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Access from Sensor to Sensor ...............................................................3-25

Using Zoom..........................................................................................3-26

Saving the Scenario....................................................................................3-28

Getting Started

The scenario you built in Chapter 2 of this tutorial serves as the basis for
performing the analysis tasks in this section.

Before you begin, make sure that the Tutorial40 scenario we created in
Chapter 2 is open in STK. If the Tutorial40 scenario is currently open, skip
ahead to the section entitled Defining a Satellite Orbit — you’re ready to
begin this exercise.

If another scenario is open, close it by highlighting the scenario’s name in the
Browser window, then selecting Close from the )LOHV menu.

When you first open STK, a Startup Wizard appears. If you’ve recently
completed the first exercise on this tutorial, the Tutorial40 scenario should
be listed in the Last Loaded Scenarios list in the Startup Wizard. Double click
on the Tutorial40 scenario in the list to open it in STK.
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If the scenario isn’t in the list, click Cancel in the Startup Wizard, then select
Open from the )LOHV menu, make sure you’re in the tutorial subdirectory, and
select Tutorial40.sc.

The Browser window and Map window are shown here for
reference.

First, let’s make sure we can see the ERS1 satellite. Open the Graphics
Properties window for the satellite and make sure that the Display Time is set
to Always On.

Defining a Satellite Orbit

In Chapter 2, we propagated four hours of ERS1 ephemeris. As a user, you
may want to calculate the orbit for the ERS1 satellite over the next 4 hours or
maybe over a full week. Our first task is to propagate ephemeris for a given
period of time.
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You may want to change orbital parameters to become familiar with the choices available.
A complete list of parameters can be found in the STK  User’s Manual.

Orbital parameters are currently displayed using the unit settings we specified in Chapter
2 of this tutorial.

In the Browser window, highlight the ERS1 satellite and select Basic from the
Properties menu.

Changing Orbital Parameters

As a user, you may want to manipulate orbital parameters to conduct
analyses using different settings. In addition, the parameters specified for a
satellite may be different from the parameters you wish to use. For instance,
you may want to use apogee and perigee altitude values instead of the
semimajor axis and eccentricity values originally entered for the ERS1
satellite. STK allows you to switch orbital parameters as often as you like.

The ERS1 satellite was originally defined with a Semimajor Axis of 3867.7846
nm. To display the Apogee Altitude value, click the down-pointing arrow  to
the right of the Semimajor Axis field with the right mouse button and
highlight Apogee Altitude in the list that appears.

Values for both Apogee and Perigee Altitudes are displayed.

1RWH
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24 Hours of Ephemeris

To generate 24 hours of ephemeris data, change the Stop Time from 1 Nov
1997 04:00:00.00  to 2 Nov 1997 00:00:00.00  and click Apply.

This calculation may take a few seconds. To speed the process, you may want to consider
changing to a larger Step Size.

The Map window now displays 24 hours of ERS1 ephemeris.

1RWH
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Full Week of Ephemeris

If you wish to display one week of ephemeris data, change the Stop Time to 8
Nov 1997 00:00:00.00  and click Apply.
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Return to a 24-hour duration for ERS1 by setting the Stop Time to 2 Nov
1997 00:00:00.00 and the Step Size to 60.00 seconds. When you
finish, click OK.

Display Times for Satellites

Sometimes it may be important to see an object in the Map window for
certain periods of time, yet at other times the display of that object may be a
distraction from other analysis efforts. You can control the display of
facilities, targets, satellites and other vehicles in the Map window.  Open the
Graphics Properties window for the ERS1 satellite and select the Display
Times tab.

Change the Display Status from Always On to Use Intervals, then enter 1 Nov
1997 00:00:00.00 in the first text box below the Interval Table and 1 Nov
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1997 01:00:00.00 in the second text box. Click Add.  Now enter 1 Nov 1997
02:00:00.00 and 1 Nov 1997 03:00:00.00 and click Add.  Click Apply.

Now click the  Animate Forward button in the Map window tool bar to see
the changes in action. Let the animation run for the full four-hour period
(remember, animation time is much faster than real time!). Notice that the
ERS1 satellite icon and text label disappear between the hours of 1 and 2 a.m.
and 3 and 4 a.m., yet the ground track remains visible.

In the Display Times window, change the Display Status back to Always On,
then click OK.

Generating a Report

The reporting feature in STK makes it easy to view and analyze data. Let’s
generate a standard report for the ERS1 satellite. A number of “standard”
formats were shipped with STK for your convenience. To create a report,
highlight ERS1 in the Browser window, right mouse click, then select Report
from the menu that appears.
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You’re going to create a report that shows attitude quaternions for the ERS1
satellite. Highlight the report style entitled Attitude Quaternions in the Styles
list and click Create… to view the data. Once you choose a report, the report
style name appears in the text box at the bottom of the window.

A window displaying ERS1 attitude quaternions appears.

Use the scroll bars on the right and bottom of the window to view additional data. You
can also click and drag the corner of the window to enlarge the size so that more data
displays. +LQW
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To close this window, select Close from the Files menu.

Now let’s view the data for ERS1’s solar AER. In the STK Report Tool
window, highlight the report style entitled Solar AER in the Styles list and click
Create… to view the data.

A window displaying ERS1 solar azimuth, elevation and range
data appears.
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Let’s print the report. Select Print from the Files menu. The report prints to
the printer specified in the Print Setup/Reports option from the STK Browser
window Files menu.

To close this window, select Close from the Files menu.

Viewing Data in Graph Format

Let’s see this same data in graph format so that you can compare and analyze
various data elements more easily.

In the Browser window, highlight the ERS1 satellite, then select Graph from
the Tools menu.
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In the STK Graph Tool window, highlight the graph style entitled Solar AER in
the Styles list and click Create… to view the data.

A window displaying ERS1 solar azimuth, elevation and range
data in graph form appears.
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You can click a point in the graph to display its X and Y coordinates as well as
the Nearest X and Y Data Points. The text box on the far bottom right of the
window shows the data element selected.

Let’s change the color of one of the data elements in the graph. Select
Attributes from the Edit menu.

A Graph Attributes window appears.

In the Element list, select Elevation, then change its color to blue.  Click OK.

The graph display and legend are updated.

To exit the Graph, select Close from the Files menu, then click Cancel in the
STK Graph Tool window.
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Dynamic Display of Data

Let’s see what the solar azimuth, elevation and range data looks like
dynamically. STK allows you to view data dynamically during animation so
that you can see the changes taking place over time.

Make sure ERS1 is still highlighted in the Browser window, then select
Dynamic Display from the Tools menu.

In the STK Dynamic Display Tool window, highlight the style entitled Solar
AER in the Styles list and click Open…. No information displays because the

scenario isn’t animating. To view data over time, click the  Animate
Forward button in the Map window tool bar.

ERS1 solar azimuth, elevation and range data appears at
specified time intervals.
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If the data is changing too quickly too read, use the  Decrease Animation Time Step
button in the Map window tool bar to slow the animation time.

To exit the Dynamic Display, select Close from the Files menu, then click
Cancel in the STK Dynamic Display Tool window.

Dynamic Strip Charts

We can also see information dynamically in graph format using the Strip Chart
tool. Make sure ERS1 is still highlighted in the Browser window, then select
Strip Chart from the Tools menu.

In the STK Strip Chart Tool window, highlight the style entitled Solar AER in
the Styles list and click Open…. No information displays because the scenario

isn’t animating. To view data over time, click the  Animate Forward button
in the Map window tool bar.

ERS1 solar azimuth, elevation and range data appears.

+LQW
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If the data is changing too quickly too read, use the  Decrease Animation Time Step
button in the Map window tool bar to slow the animation time.

To exit the Strip Chart, select Close from the Files menu, then click Cancel in
the STK Strip Chart Tool window.

Generating Orbits for all Satellites

In the first part of this exercise, we altered the propagation of only one
satellite’s orbit. You may want to propagate all of the satellites in a scenario
for the same amount of time. The Time Period setting only affects satellites
and has no effect on nonorbiting vehicles, such as ground vehicles, aircraft,
launch vehicles, etc.

To propagate all satellites in the scenario, open the Basic Properties window
for the Tutorial40 scenario and click the Time Period tab.

+LQW
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Set the Start Time at 1 Nov 1997 00:00:00.00 and the Stop Time to 2 Nov 1997
00:00:00.00. Click OK. As you can see from the ground tracks in the Map
window following, all the satellites now have ephemeris for the 24-hour
period specified.
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Calculating Access

Now that we have 24 hours of ephemeris propagated for all satellites, we
want to determine the access between ERS1 and the Shuttle to a facility, a
target, and  between the two satellites.

Access from a Facility or Target to
Satellite

In the Browser window, highlight the Santiago facility, and select Access from
the Tools menu.

In the Associated Objects list, highlight ERS1� then make sure that the Show
Line, Animate Highlight and Static Highlight options in the Graphics field are
ON. Now click Compute.



Intermediate Skills

Satellite Tool Kit® Tutorial 3-19

The Map window is updated to highlight the portion of the
ground track during which access between ERS1 and Santiago is
possible.

Now that the graphics for the access have been displayed, let’s determine the
start and end time of each access as well as the duration. Make sure that ERS1
is highlighted in the Associated Objects list of the Access window. In the
Reports field, click the Access… button to display associated access data in a
report format.
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Close the Access Report window. To see the data presented in graph form,
click the Access… button in the Graphs field.

You can click a point in the graph to display its X and Y coordinates as well as
the Nearest X and Y Data Points. The text box on the far bottom right of the
window shows the data element selected.

To exit the Graph, select Close from the Files menu, then click Cancel in the
STK Graph Tool window.

To remove access graphics from the Map window, highlight ERS1 in the
Associated Objects list and click the Remove Access button.

Our next task is to see when Santiago has access to the Shuttle. In the Access
window, highlight Shuttle in the Associated Objects list and click Compute.

The Map window now displays the access between the Shuttle
and Santiago.
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For this access, let’s see azimuth, elevation and range data. Click the AER…
button in the Reports field.

An AER Report window appears summarizing azimuth,
elevation and range.
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Keep this window open. In the Access window, click the AER… button in the
Graph field to see this same data in graph form.

Now close both the Graph and Report windows and click Cancel in the
Access window.

Oops! We forgot to clear accesses from the Map window. Highlight the
Tutorial40 scenario in the Browser window, right mouse click and select
Remove Accesses from the menu that appears.

All accesses are cleared from the Map window.

Access from Satellite to Satellite

We now want to find out when two satellites have access to each other. In
our next exercise, we’ll determine when the Shuttle has access to TDRS_4.



Intermediate Skills

Satellite Tool Kit® Tutorial 3-23

Open the Access window for the Shuttle satellite, highlight TDRS_4 in the
Associated Objects list and click Compute.

Access between the two objects displays in the Map window.

Also look at the access constraints in the second Map window, showing the
Perspective view.

Let’s get ready for the next exercise by clearing our choices in the Access
window. Highlight *TDRS_4 in the Associated Objects list and click the

 button. Keep the Access window open for our next task.

Access Using Azimuth, Elevation,
and Range (AER)

In our scenario, we have two satellites in a Low Earth Orbit (LEO): the
Shuttle and ERS1. Our next task is to determine when they have access to
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each other and what the azimuth, elevation and range is between the two
satellites during access times.

In the Access window, highlight ERS1 and click Compute.

Accesses between the two objects are displayed in the Map
window.

Now click Access... in the Reports field to see a summary of access times.
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To close this window, select Close from the Files menu.

Access from Sensor to Sensor

So far, we’ve determined and displayed fairly simple satellite-to-facility,
satellite-to-target, and satellite-to-satellite access. Often, facilities, targets or
satellites have one or more sensors attached to them. These sensors limit the
direction from which another object can successfully access the first object.

As we learned in Chapter 2, sensors can be either relative or target pointing.
It is important to remember that a sensor is also defined as an object and can
be attached to any facility, target or satellite. Once the sensor is attached to a
“parent” object, we need to define the shape of its beam and the direction in
which it is pointing.

In this exercise, we’ll add an antenna to the Shuttle (assume that it is in the
payload bay) and point it straight up. We’ll also add a user antenna to
TDRS_4 and point it straight down. Then we’ll determine access between the
two.

Adding Sensors

We’re just going to insert both sensors.  In the Browser window, highlight
the Shuttle satellite, then select Insert… from the Files menu. Change
directories to the tutorial subdirectory (the directory where you originally
saved this scenario), change the File Type to Sensor, and highlight antenna.sn.
Click OK.

Select the TDRS_4 satellite in the Browser window and follow the same
procedure to insert the UserAntenna.
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Determining Access Between the
Sensors

Our next task is to determine the access between the Shuttle’s Antenna and
the TDRS_4’s UserAntenna.

Make sure that UserAntenna is still highlighted in the Browser window, right
mouse click and select Access from the menu that appears. Highlight the
Shuttle’s Antenna sensor in the Associated Objects list and click Compute.

You may need to expand the object tree for both the TDRS and Shuttle satellites so that
you can see the attached sensors in the Associated Objects list.

Notice that the ground tracks for both satellites are highlighted when there is
access; however, the TDRS_4 satellite’s ground track is small. Let’s zoom in
on this area for a closer look.

Using Zoom

In many analysis situations, there may only be a small portion of the map
that is of interest. STK provides you with infinite Zoom capability. In
addition, if you have the High Resolution Maps module, you can switch
among maps as you zoom in closer to the Earth.

This exercise assumes that the full installation of High-Resolution Maps is installed on your
system or network. If you don’t have the Hi-Resolution Maps module installed, the level of
detail pictured here don’t display as you zoom closer.

To set parameters for switching among map resolutions, click the button on
the Map window tool bar and select the Resolution tab.

1RWH
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Turn the Use option ON, then select the Details tab. In the Details tab, click
Advanced…, then select all of the options for Rivers and Lakes, and change
the Display option to YES. Click OK. In the Details tab, click Apply.

Now click the Zoom In button on the Map window tool bar. For this
exercise, click in the Pacific Ocean just below California, hold down the
mouse button and drag the cursor so that box encompasses all of South
America. Repeat this process until you are zoomed in over the middle of
South America at a distance of approximately 2 nautical miles.

As you zoom closer and closer, the resolution of the Map changes.
The type of Map being used is displayed in the bottom of the Map
window to the left of the animation time.

Now turn OFF all Rivers and Lakes in the Details tab and click Apply.  Use

the  Zoom Out button as many times as necessary to return the Map
window to a normal view, then turn the Use option in the Resolution tab
OFF and click OK.

Make sure to Zoom Out to a normal view before you turn the Use option OFF; otherwise,
the default resolution remains at the level displaying on the Map at the time you turn the
Use option OFF.

:DUQLQJ
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Clean Up

To clear the access graphics from the display, click the Remove All
button in the UserAntenna’s Access window, then click Cancel.

Saving the Scenario

Before proceeding to Chapter 4, or if you wish to stop here, you should save
your new scenario. Highlight the Tutorial40 scenario in the Browser window,
and select Save from the Files menu.

The system saves the scenario and all objects created for and
inserted into the scenario.

To exit STK, select Exit from the Files menu.
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Goal for this Section

The objective of this section is to learn how to use a number of STK tools,
including the Satellite Database, City Database, Long-term Orbit Predictor (LOP),
and advanced Graph features. You’ll also learn more about the Map window and
how to display background graphics, change projection types, and print.
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Getting Started

Before you begin, make sure that you don’t have a scenario open in STK. If
another scenario is open, close it by highlighting the scenario’s name in the
Browser window, then selecting Close from the )LOHV menu.

The Map window appears when you create a scenario.

First, let’s make sure we’re in sync with scenario units.  Highlight the
scenario in the Browser, right mouse click and select Basic in the menu that
appears. Click the Units tab.  Make sure the scenario’s Distance Units are set to
Kilometers, Time Units are set to Seconds, Date is set to Gregorian UTC and
Small Distance Units are set to Meters.
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Access from a Planet or Star

First, we’re going to look at access between a satellite and a planet. For this
exercise we need to add the Hubble space telescope and the planet Jupiter to
the Tutor2 scenario.

To add the planet Jupiter to the scenario, click the  icon and name the new
planet Jupiter. To set the properties of the planet, open its Basic Properties
window.

In the Definition tab, select JPL DE-403, then highlight Jupiter in the menu and
click OK.

Now we’re going to add the Hubble space telescope to our scenario. Select
Insert…from the Files menu, then change the File Type to Satellite and select
Hubble.sa in the tutorial directory.

When you save an object in STK, STK saves the object itself and any subobjects (such as
sensors, receivers, transmitters) attached to the object. In this instance, a sensor is attached
to the Hubble telescope and is inserted along with the satellite. 1RWH
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The Map window displays the new satellite and a sensor that was
attached to the Hubble.

Open the Basic Properties window for Sensor and select the Pointing tab.

We want this sensor to point at Jupiter. To do so, change the Pointing Type to
Targeted and the Boresight Type to Tracking. Now select Jupiter in the Available

Targets list and use the  to copy it the Assigned Targets list. When you
finish, click OK.
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We’re now ready to determine access between the Hubble’s Sensor and the
planet Jupiter. Open the Access window for Sensor, select Jupiter in the
Associated Objects list and click Access… in the Reports field to view access
times.

Close the Access Report window.

In the Access window, click the Remove Access button, then click OK. Now
we’re ready for our next exercise.

Satellite Swath

As a user, you may need to create a swath along a satellite’s ground track to
display a coverage area for a satellite.
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Creating the Satellite Swath

To create a satellite swath, highlight Hubble in the Browser window, right
mouse click and select Swath in the menu that appears.

Change the Ground Elevation to 35.00° and turn the Filled Limits option ON.
Click Apply.

The Map window displays the swath with a cross track at each of
the ephemeris points (determined by the Step Size of the
propagated ephemeris).
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Now select No Graphics in the Swath window and click OK.

Using the Long-term Orbit Predictor

Next, we’re going to use the Long-term Orbit Predictor (LOP) to see how
much a satellite’s orbit changes over a period of two years.  In the Browser
window click the satellite icon. When the Orbit Wizard appears, click Cancel.
Name the new satellite LOPSat. Now open the satellite’s Basic Properties
window.

In the Orbit tab, set the following parameters:

Orbital Element Setting

Propagator LOP

Start Time 1 Nov 1997 00:00:00.00

Stop Time 1 Nov 1999 00:00:00.00
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Orbital Element Setting

Step Size 1 day

Orbit Epoch 1 Nov 1997 00:00:00.00

Coordinate Type Classical

Coordinate System J2000

Apogee Altitude 35828.181213

Perigee Altitude 35743.852905

Inclination 28.5

Argument of Perigee 360.0

Lon Ascn Node 260.0

True Anomaly 300.35

When you finish, click the Force Models… button on the Orbit tab.

In this Force Models window, we’re going to change the Earth Gravity
Maximum Degree and Maximum Order to 6. Make sure the Use Solar Radiation
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Pressure is ON and the Use Drag option is OFF. Click OK, then click OK
again in the Orbit tab.

A progress indicator appears while STK computes the data.

When STK is finished, highlight the LOPSat in the Browser, then select
Graph from the Tools menu.

Let’s make a new style to graph the orbit parameters. In the STK Graph Tool,
click the New button, then type LOP Graph in the text box below the Styles
list and click Change. Now click the Properties… button to define the graph’s
options.
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In the Contents tab, open the LOP Mean Elements folder in the Elements list
and select Argument of Perigee. Use the right arrow button to copy this
element to the y list.  Now copy Semimajor Axis from that same folder to the
y2 list. When you finish, click the Layout tab.
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In this tab, enter LOP Orbital Elements in the Title field, then click OK.

Let’s see what our graph looks like. In the STK Graph Tool window, click
Create….
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Animating a Scenario

So far in this tutorial, we’ve worked mainly with static displays. We’re going
to add a few facilities to the scenario, then animate to see when the satellites
have access to facilities.

First, select Insert… from the Files menu, change the File Type to Facility, and
select Santiago.f and Baikonur.f in the tutorial subdirectory (the directory in
which the Tutorial40 scenario is saved).
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Using the City & Satellite Databases

Now, highlight the Tutor2 scenario in the Browser window and select City
Database from the Tools menu.

Turn the Country option ON and select Brazil, then turn the City Type option
ON, and select Administration Center. Click Perform Search.
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When the City Database Search Results window appears, select Rio de Janeiro in
the list of cities and click OK, then click Cancel in the City Database window.

Now, let’s add a few more satellites to the scenario. Make sure the Tutor2
scenario is still highlighted and select Satellite Database in the Tools menu.

In the Satellite Database window, turn the Mission option ON, then select
Comm-Civil as the mission type. Click Perform Search.

When the Satellite Database Search Results window appears, select SYNCOM
2 (ssc# 00634) and click OK, then click Cancel in the Satellite Database
window. Now open the SYNCOM_2’s Basic Properties window and change
the Start Time to 1 Nov 1997 00:00:00.00, the Stop Time to 2 Nov 1997
00:00:00.00, and click OK.

Notice the ground track of the SYNCOM satellite is a defined
figure eight in the Map window.

The last satellite we’re going to add to this scenario is a satellite in sun
synchronous orbit. In the Browser window, click the  satellite icon. When
the Orbit Wizard appears, click Next. In the next window, select Sun
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Synchronous and click Next. We’ll leave the default settings for this satellite,
so continue through the Wizard.

Animating the Scenario

To animate the scenario, simply click the  in the tool bar at the top of the
Map window.

Use the buttons on the Map tool bar (refer to Table 4-1) at the top of the
Map window to control map animation. Click  to stop the animation.

Table  4-1.  Tool bar buttons

Button Description Button Description

Print the Map window. Animate in forward sequence.

Decrease time step. Move forward one step.

Reverse one time step. Increase time step.

Play in reverse. Zoom in (magnify). Click and
hold the left mouse button, then
drag the mouse.

Pause. Zoom out.

Stop and reset. Resize to 2:1 aspect ratio.

Measure distance between
two points. Click on this
button, then click and drag
the mouse between the
points.

Open the Map Properties window.
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Generating Combination Reports

STK gives you the ability to generate a single report that summarizes
different objects. For instance, you could generate a report that summarized
specified data for facilities, targets and satellites. We’re going to generate a
report  that shows the position of the Santiago facility, Rio de Janeiro and the
Hubble satellite. To do this, highlight all three in the Browser, right mouse
click and select Report from the menu that appears.

In the STK Report Tool window, select Fac and Vehicle Position in the Styles
list, then click Create….

Close the Report window, then click Cancel in the STK Report Tool window.
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Map Projections

So far, we’ve used only one of several different map projections available in
STK. For our next task, we’re going to experiment with the various map
projections available. We’ll leave the Equidistant Cylindrical Map projection
in the original Map window, but we’ll open a second Map window so that we
can compare the two.

In the Browser window, highlight the Tutor2 scenario, then select New Map
Window from the Tools menu. When the second Map window appears, click
the  button on the tool bar to open the Map Graphics Properties window.

Select the Details tab. As an introductory exercise, let’s turn the map’s
latitude and longitude lines ON. Now let’s review some of the different map
projections available in STK. Click the Projection tab.

Change the Projection Type from Equidistant Cylindrical to Mercator and click
Apply.

The Map window displays a different view.
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Change the Longitude to -80.0
0
 and the projection type to Miller, then click

Apply.

The Map window displays a Miller projection with the map’s
center at -80.0

0

 longitude.

Change the Projection Type to Mollweide and click Apply, then change it to
Sinusoidal and click Apply.
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Now change the Projection Type to Orthographic, the Latitude to 20.0°  and
leave the Longitude at -80.00 . Click Apply. Change it to Stereographic and
Click Apply.

To see an example of a polar projection, select Azimuthal Equidistant, then set
the Latitude to 90.00°  and the Longitude to 0.00° . Click Apply. Then select
Hammer-Aitoff and click Apply.
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Printing Maps

The Perspective map projection is a nice 3-D graphic for us to print. Set the
Projection to Perspective, the Orbit Display to ECI, Latitude to 0.0 , Longitude to
-80.0 , and the Altitude to 20000.0 . When you finish, c lick Apply.

If the images are not printing properly, check the Printer Setup using the Print
Setup/Reports option from the Files menu. This command should be set to the same
command you would use from a command line to print a PostScript file. If you don’t know
what the setting should be, consult with your System Administrator.

In the Map window, click the  button on the left-hand side of the tool bar.
The following image should be at your printer:

1RWH
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To prepare for the next exercise, let’s clean up the STK environment by
setting the Latitude to 0.0 °, Longitude to 0.0° , and the Projection back to
Equidistant Cylindrical. Then go back to the Details tab and reset the Lat/Lon
Lines so that they don’t show and click Apply.

Map Backgrounds

You can also apply a different background to display in the Map window. In
the Details tab, set the Background to AGI1024.xpm and click OK.

The Map window now displays a textured background.

You can display a personalized map background in the Map window or use
one of the background images shipped with STK.
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Saving the Scenario

Before proceeding to Chapter 5, Advanced Skills, or if you wish to stop here,
you should save the scenario.
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5
ADVANCED

SKILLS

Goal for This Section

With STK, access to a target or facility can be constrained by minimum and
maximum azimuth angles, elevation angles and range. A satellite or a sensor
can be constrained by minimum and maximum azimuth, elevation angles,
range, grazing angles, grazing altitudes, and ground elevation angles as well as
the earth background.

In this exercise, you’ll learn to manipulate the constraints for a facility and a
satellite sensor. If you’re unfamiliar with the limits to access discussed here,
please review the STK User’s Manual STK User’s Manual before beginning.

This chapter also includes instructions for displaying a ground sensor at a
designated altitude. We’ll wrap up the tutorial by looking at lighting
conditions, lighting data and lighting graphics during animation;
investigating sensor swath; animating a scenario involving a missile launch;
and customizing a report.
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Chapter Contents

Goal for This Section ....................................................................................5-1

Chapter Contents.........................................................................................5-2

Getting Started.............................................................................................5-2

Facility and Target Constraints .....................................................................5-3

Setting Facility Constraints.......................................................................5-5

Setting Up the Associated Object ...........................................................5-6

Calculating the Access ............................................................................5-7

Satellite Sensor Constraints .........................................................................5-10

Summary and Clean Up .......................................................................5-12

Displaying a Ground Sensor Pattern at a Specified Altitude .......................5-12
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Generating a Walker Constellation ............................................................5-16
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Setting Up the Lighting Attributes.........................................................5-21

Lighting During Animation...................................................................5-23
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Final Notes .................................................................................................5-28

Getting Started

<Install Dir> indicates the directory name in which STK files were loaded at installation.

For this section of the tutorial, we are going to use a number of objects
already created in the previous chapters.
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Before you begin, make sure that you don’t have a scenario open in STK. If
another scenario is open, close it by highlighting the scenario’s name in the
Browser window, then selecting Close from the )LOHV menu.

When you first open STK, a Startup Wizard appears. Click Cancel in the
Startup Wizard, then click the  (Scenario icon) to create a new scenario.
Name the scenario Tutor3.

To review instructions for setting Units please refer to “Setting the Tutorial Environment” in
Chapter 2.

Before beginning this exercise, make sure the scenario’s Units are set to UTC
Gregorian, Nautical Miles and Seconds. Then make sure that the scenario’s
Start Time is set to 1 Nov 1997 00:00:00.00 and Stop Time is set to 2 Nov 1997
00:00:00.00.

Facility and Target Constraints

Now let’s add a few of the facilities created in Chapter 2 of this tutorial.
Select Insert… from the Files menu, then make sure you’re in the tutorial
subdirectory and change the File type to Facility. Insert the Baikonur, Perth
and Santiago facilities. Now use these same procedures to insert the ERS1
satellite. Open the Graphics Properties window for the satellite and make
sure that the Display Time is set to Always On.

Now let’s add a few of the facilities created in Chapter 2 of this tutorial.
Select Insert… from the Files menu, then make sure you’re in the tutorial
subdirectory and change the File type to Facility. Insert the Baikonur, Perth
and Santiago facilities. Now use these same procedures to insert the ERS1
satellite.
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To begin this exercise, we need to magnify the area around the Santiago
facility in the Map window so that the constraints we impose are clearly
visible.

In the Map window, click the Zoom In  button on the tool bar. Now
position your cursor in the Map window, hold down the left mouse button
and drag the mouse until the Map displays a box around the Santiago facility.
Release the mouse button so that the Map is magnified to display the area
within the box.
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Next, we need to change the color of the facility in the Map window so that
it is more clearly visible. Highlight the Santiago facility in the Browser
window, then select Graphics from the Properties menu.

Change the color of the facility to Red, then click OK.

Santiago is displayed in red on the map.

Setting Facility Constraints

The graphics don’t change because these constraints only apply at the time an access is
calculated with the facility.

Now we want to set some constraints for Santiago. Select Santiago in the
Browser, then right mouse click and choose Constraints from the menu that
appears.

1RWH
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Make sure that the Azimuth Angle options are ON. Change the value for Min.

Azimuth Angle to 45.0
0
 and the value for Max. Azimuth Angle to 135.0

0
.

Click OK.

Setting Up the Associated Object

We want the constraint pattern to be clearly visible so we’ll propagate a week
of ERS1 ephemeris before calculating the access.

Open the Basic Properties window for the ERS1 satellite.

We are creating a week of ephemeris for ERS1, so STK may take a few minutes to calculate
the data.

1RWH
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In the Orbit tab, change the Stop Time to 8 Nov 1997 00:00:00.00 , then
click OK.

Calculating the Access

Now open the Access window for the Santiago facility.
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In the Associated Objects list, highlight ERS1 and click Compute. The Map
window displays the access from the Santiago ground station to the ERS1
satellite.

Now we can manipulate the access constraints and see an interactive update
in the Map window. Open the Constraints Properties window for the
Santiago facility.

In the Basic tab of the Constraints Properties window that appears, change

the Min. Azimuth Angle to -60.0
0
, Minimum Elevation Angle to 20.0 °,

Maximum Range to 500.0 nm , Minimum Azimuth Rate to -180.00 ° per
second . Make sure each option is ON. Click Apply.

STK recalculates the access and displays an updated Map
window.
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Experiment with different access constraints as you wish. When you finish,
make sure all constraints are OFF and click OK. The Map window displays
full horizon-to-horizon access.

Before continuing, clear the Map window of access graphics. Open the Access
window for the Santiago facility, click the Remove Access button, then click
Cancel. Then Zoom Out  to the normal Map view.
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Satellite Sensor Constraints

Our next task is to constrain access to a satellite sensor. We’ll use the
Horizon sensor attached to the ERS1 satellite.

Begin by looking at an unconstrained access to the Horizon sensor. Open
the Access window for the sensor, select Baikonur as the Associated Object
and click Compute.

Now click the Access… button in the Reports field of the Access window to
view data in a report form. An Access Report window appears.
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When you finish, close the Report window.

Now let’s set some constraints on the Horizon sensor. Open the Constraints
Properties window for the sensor. Change the Min Azimuth Angle to -60.0°
and the Max Range to 500.00  nm, then click OK. Make sure the options are
ON.

The Map window updates to display the constrained access.
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Summary and Clean Up

We’ve completed two fairly straightforward exercises using constraints;
however, constraints can be quite complex. For instance, you may have a
constrained facility and perform an access with a constrained satellite, or
satellite sensor, by setting constraints for both objects.

Now let’s clean up the display before proceeding to the next exercise.
Remove all accesses for the  Horizon sensor so that access graphics are
cleared from the Map window.

To prepare for the next exercise, set the propagated orbit to 24 hours for all
objects. Open ERS1’s Basic Properties window, change the Stop Time to 2
Nov 1997 00:00:00.00 and click OK.

Displaying a Ground Sensor Pattern at
a Specified Altitude

In this section, we’ll add an uplink sensor to the Baikonur facility and display
the defined pattern at a designated altitude.

In the Browser window, create a new sensor named Uplink  and attach it to
the Baikonur facility.

First, we need to define the sensor and identify where it’s pointing. Open the
Basic Properties window for the Uplink sensor.
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Set the Sensor Type to Half-Power, change the Frequency to 1.00  GHz and
the Diameter to 0.185  m. When you finish, click the Pointing tab.

Make sure the Pointing Type is set to Fixed, then change the Azimuth to
120.0

0
 and the Elevation to 5.0

0
. Click OK.
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Now open the sensor’s Graphics Properties window and change the Color to
Red and the Line Width to 3, and make sure the Style is Solid. Click on
Projection. Set the Minimum Altitude to 100.0  nm, the Maximum Altitude to
500.0  nm, and the Step Count to 5. When you finish, click Apply. The Map
window displays the sensor pattern at altitudes of 100, 200, 300, 400 and 500
nautical miles. Now zoom in over the Baikonur facility for a closer look.

Next, let’s display our pattern at only the ERS1 altitude, which we know is
located at approximately 424.0 nm (as defined by ERS1’s orbital elements),
In the Projection tab of the Graphics Properties window, change the Min.
Altitude to 0.0 , Max. Altitude to 424.0 , and the Step Count to 1; then click
OK.
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We can now display the access from Baikonur’s uplink sensor to the ERS1
satellite. Open the Access window for the Uplink sensor, select ERS1 in the
Associated Objects list and click Compute, then click Cancel. Now zoom out
to return to the normal Map view. The Map window is updated to display
access graphics for the area within the sensor’s range.
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Clean Up

Highlight the Tutor3 scenario in the Browser window, and select Remove
Accesses from the Tools menu. Now open the Graphics Properties window
for the Uplink sensor, click the Projection tab and change the Step Count to
0, then click OK.

The Map window no longer displays access graphics.

Generating a Walker Constellation

A Walker constellation consists of a group of satellites (t) that are circular in
orbits and have the same period and inclination. The pattern of the
constellation consists of evenly spaced satellites (s) in each of the orbital
planes (p) specified so that t=sp. STK makes it easy to generate a Walker
constellation.

We’ll begin this exercise by creating a new scenario. In the Browser window,
highlight the Tutor3 scenario and select Close from the Files menu.

Now click the  icon to create an new scenario. Change the default name of
Scenario# to the new name, Tutor4 , and press 5. Highlight Tutor4 in
the Browser window.

Now open the Basic Properties window for the Tutor4 scenario. Make sure
the scenario’s Time Period tabs are set to 1 Nov 1997 00:00:00.00  for
Start Time and 1 Nov 1997 04:00:00.00  for Stop Time.

Now, create a new satellite named Walker  and open its Basic Properties
window.
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In the Orbit tab of the Basic Properties window, Change the Semimajor Axis
field to Period. In the Period field, enter 7200  seconds. Change the Inclination

to 70° and the Stop Time to 1 Nov 1997 02:00:00.00, then click OK.
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Now we’ll generate a Walker constellation. Highlight the Walker satellite in
the Browser window, and select Walker from the Tools menu. A Walker
window appears.

Set the Number of Planes to 1, the Number of Sats per Plane to 4 and the Inter-
place Spacing to 0 and click Apply.

Now change the Number of Planes to 2, the Number of Sats per Plane to 4 and
the Inter-plane Spacing to 1 and click OK.



Advanced Skills

Satellite Tool Kit® Tutorial 5-19

We can leave this scenario as it is for the next exercise.

Lighting

It is often necessary for the analyst to understand the lighting conditions for
a satellite. STK allows you to display this information both in report and
graph format. STK can depict the lighting conditions of the satellite by
changing the color of the ground track to visually display those conditions in
the Map window. STK can also display the solar terminator and the subsolar
point during animation.

In the Browser window, create a satellite. When the Orbit Wizard appears,
click Next, then select Molniya and click Next.
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In the Molniya Orbit Wizard window, make sure the Apogee Longitude is set
to -100.00° and the Perigee Altitude is set to 5000 meters. Click Next. In the
next Orbit Wizard window, change the Start Time to 1 Nov 1997 00:00:00.00,
the Stop Time to 2 Nov 1997 00:00:00.00, and the Step Size to 60 seconds.
Name the new satellite Molniya.
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Setting Up the Lighting Attributes

Now open the Graphics Properties window for the Tutor4 scenario and click
the Sun Lighting tab.

Set the Sunlight properties as shown in the table below. Make sure the
options are turned ON.

Table  5-1.  Sunlight properties settings

Field Setting

Subsolar Point Set the Color of the Subsolar Point to Yellow and the
Line/Marker Style to Circle.

Sunlight/Penumbra Set the Color of the Sunlight/Penumbra to Red, Line
Style to Solid and Line Width to 3.

Penumbra/Umbra Set the Color of the Penumbra/Umbra to Magenta,
Line Style to Solid and Line Width to 3.

When you finish, click OK, then click Reset  on the Map window tool bar
to display the new Sun lighting graphics.

Notice the small circle on the far right side of the Map window (beneath the Walker 1
satellite) designating the Subsolar Point.

+LQW
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Now, let’s view Sun lighting data in report format. Open the STK Report Tool
window for the Molniya satellite.

In the STK Report Tool window, highlight Lighting Times in the Styles list and
click the Create… button. A Lighting Report window appears.
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Close both Report windows.

Lighting During Animation

In the Browser window, highlight Molniya and select Lighting from the
Tools menu.
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Set the Sunlighting properties as shown in the table below. Make sure
the  options are turned ON.

Table  5-2.  Sunlighting properties settings

Field Setting

Sunlight Set the Sunlight Color to Yellow, the Line/Marker
Style to Dashed and the Line Width to 4.

Umbra Set the Umbra Color to Cyan, the Line/Marker
Style to Solid and the Line Width to 2.

Show
Sunlight/Penumbra
Line at Satellite
Altitude

Turn this feature ON.

When you finish, click Apply. The Map window displays the new Sun lighting
graphics.
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Now click the Animate Forward  button in the tool bar to animate your
scenario. Notice how the area that shows lighting for the Molniya satellite
changes in size and shape.

Click the Reset  button to stop the animation.

In the Lighting window, click the AER Data… button to access a Lighting
Report with AER data.
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Clean Up

If you wish to save the work you’ve completed in the Tutor4 scenario, do so
now. When you finish, select Close from the Files menu.

The Map window disappears.

Sensor Swath

In the Browser window, select Open from the Files menu, then highlight the
Basic scenario located in the Basic Scenarios subdirectory of Data.
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In the Browser window, select BasicSensor1, right mouse click and select
Swath in the menu that appears.

Turn the Swath option ON. Set the Swath Color to Royal Blue, the Line Style to
Solid, and the Line Width to 2. Click Apply.
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You’ve made it! We’re finished the last chapter of the tutorial.

Final Notes

These exercises illustrate only a portion of STK’s capabilities. You may want
to review the SSTTK K UUsseerr’’s s MMaannuuaall for more complete information about
features you’ve worked with in this tutorial, or to learn about other aspects
of STK not addressed here.

Please call our toll-free number (1-800-220-4STK) if you have any questions
or need assistance in performing your analysis tasks.
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needs and expectations. Your comments are an important part of our success. If
you have any suggestions, please contact us via the World Wide web at
www.stk.com or e-mail us at info@stk.com . For our reference, please include the
following information along with your response.

Product: Version:

Platform: o   UNIX        o  PC      o  VAX/VMS Type:

Manual Title: ID #:

   Overall Rating of Manual:        o Very Good       o  Good      o Satisfactory      o Fair          o
Poor

Comments/Suggestions:

Name:

Title

Company

Address:

We appreciate your suggestions and will consider each response
carefully. Thank you.

 Analytical Graphics, Inc.

660 American Avenue
King of Prussia, PA 19406

(610) 337-3055 /(800) 220-4785
Fax: (610) 337-3058/ E-Mail: info@stk.com
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